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Not all clouds are created equal
A comparison of Google Sites and Microsoft SharePoint Online

Internal sites give your employees the ability to share ideas, connect with each other, and access 
everything from project-related documents to company policy and calendars. This can improve 
employee productivity and company culture. The easier it is to set up, update, and access these 
crucial lines of communication, the more likely users will actually use them. 

Here at Principled Technologies, we evaluated how easy it was to create and maintain internal sites 
with Google Sites™ and Microsoft®  SharePoint® Online.1

Google Sites, a part of G Suite,  performed 100 percent of the routine site management tasks we 
tackled in less time and with noticeably less effort than the Microsoft Office 365® site manager, 
SharePoint Online. Google Sites also delivered a streamlined user experience and responsive 
mobile design that SharePoint Online couldn’t match—SharePoint Online required more steps to 
add simple features to a team site, something Google Sites made comparably simple. Read on to 
learn more.

PREVIEW A  
SITE THEME  

in up to  

98%
 

LESS TIME

CREATE A  
NEW SITE  

in up to  

57%
 

LESS TIME

EMBED A 
YOUTUBE™ VIDEO  

in a page in  

10 

FEWER STEPS

A Principled Technologies report: Hands-on testing. Real-world results.
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Break down barriers to success 
Keeping internal sites up to date has traditionally taken a great deal of time and energy. Both G Suite 
and Microsoft Office 365 claim that their tools make it easy to build and maintain internal sites, 
but which one comes out on top?

We determined how long it took to create sites and maintain existing ones with 
Google Sites and Microsoft SharePoint Online. We also compared the number of 
steps both tools required to complete common tasks like adding text, images, 
video, and calendars to a page. Because mobility is crucial for the enterprise, 
we used a variety of laptops and smartphones running different operating 
systems, browsers, and apps to test real-world scenarios.  

Having important information at your team’s fingertips at all times 
means everyone can do their jobs better, check the status of projects 
more easily, and respond to problems more quickly. When employees 
struggle to share information with their teams or feel that their 
tools aren’t helpful, they may decide to stop wasting time trying to 
communicate in that forum and revert to old communication practices 
that are harder to track.

The clock is ticking…

Read below to see how Google Sites and SharePoint Online can improve 
(or impede) productivity.

A tale of two HR managers
Genevieve and Ralph are in charge of people operations at competing cell 
phone providers. Both need to create internal sites where employees can learn 
about new 401(k) options. They must embed video, add images, and edit copy for 
these pages. 

Genevieve’s company uses G Suite and Ralph’s company uses Microsoft Office 365. 

Let’s see how each choice shapes their workflow.
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Core competencies
Routine tasks shouldn’t be complicated. As our results show, Google Sites helps Genevieve accomplish every 
task in fewer steps than Ralph, who uses Microsoft SharePoint Online.  

The real advantage isn’t only saving steps when you embed videos or upload images to a page—it’s the fact that 
Google Sites is generally easier to use than SharePoint Online. 

Google SitesSharePoint Online

Common tasks

15 steps 5 steps

Embed YouTube video in page

3 steps 2 steps

Add text to a page

6 steps 1 step

Move inserted image

7 steps 2 steps

Resize inserted image

9 steps 3 steps

Add image to page from computer (upload)

4 steps 3 steps

Add calendar

7 steps 3 steps

Add bulleted list and one item

5 steps

Create new page

4 steps

4 steps

Change site/page theme
2 steps

35
FEWER STEPS

with Google Sites
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Strategic information management
Genevieve and Ralph now need to update their respective sites by changing the color scheme on the shared 
calendar and reviewing individual team pages.

It only takes Genevieve half a second to preview a site theme with Google Sites on her Windows® 10 laptop. In 
contrast, Ralph stares at the computer screen for over half a minute as he waits for SharePoint Online to preview 
the changes. 

Opening a page for editing takes Genevieve about a second with Google Sites—half the time it takes Ralph 
to do the same thing with SharePoint Online. When you’re reviewing dozens of team pages and adding new 
information to existing files, time quickly adds up; and when you don’t have the fastest tools helping you, routine 
tasks take up more time than they need to.

35.4 sec 0.6 sec

OS X®

37.6 sec 0.6 sec

Windows 10

2.2 sec 1.0 sec

OS X

2.2 sec 0.9 sec

Windows 10

Google SitesSharePoint Online

Preview a site theme 
in up to

98%
less time

with Sites

Open an existing page
for editing in up to

59%
less time

with Sites
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Encourage knowledge sharing
Genevieve and Ralph are creating new sites for their sales reps. They need to make group sales histories, 
prepare commission breakdowns for store managers, and create a list of sales targets for all territories. 
Once they’re done, they’ll send email notifications to individual sales reps and their managers to inform 
them that the sites are live.

Google Sites helps Genevieve achieve her goals much faster than Ralph can with SharePoint Online. 
Creating a new site with three blank pages takes Genevieve as little as 7.8 seconds (when she’s using an 
Apple® MacBook Air®). The same task takes Ralph as long as 18.4 seconds. That’s twice as long as it takes 
Genevieve! When you multiply that time savings over 15 or 20 new project sites, it’s clear that Genevieve 
can start working on other objectives while Ralph’s still far from done with his list.

Once each new project site is ready to go, Genevieve lets various team members know that their new 
team portal is up and running. With Google Sites, Genevieve accomplishes this in less time than it takes 
Ralph to notify his workers with SharePoint Online.

Create a new site 
in up to

57%
less time

with Sites

Create a new 
blank page in up to

60%
less time

with Sites

Invite/share via 
email in up to

42%
less time

with Sites

12.7 sec 5.4 sec

OS X

1.9 sec 0.8 sec

OS X

4.0 sec 2.3 sec

OS X

9.5 sec 4.7 sec

Windows 10

2.0 sec 0.8 sec

Windows 10

3.4 sec 2.7 sec

Windows 10

Google SitesSharePoint Online
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Get the whole picture
Saving time and steps is important, but that’s not the only difference between Google Sites and Microsoft 
SharePoint Online.  

The Google Sites experience

Google Sites presented our testers with a consistent experience across devices, including Android and iOS 
smartphones. It also created responsive pages that scaled properly on both laptop and mobile screens.

Google Sites

Google SitesSharePoint Online

SharePoint Online

What a page editor on desktop sees

What a user on desktop sees



Not all clouds are created equal: a comparison of Google Sites and Microsoft SharePoint Online November 2016 | 7

The Microsoft SharePoint Online user experience:

Microsoft SharePoint Online has some mobile support, but what you see when designing a site isn’t always what 
you get. For example, in the screenshot on the left, the page title’s formatting doesn’t match how it appears in 
the SharePoint Online editor screen on the previous page, and you only see half of the image; you have to scroll 
horizontally to see the whole thing.

In contrast, Google Sites was mobile friendly and didn’t have any issues fluidly scaling from mobile screen sizes 
to laptops.

Google SitesSharePoint Online

What a mobile user sees
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Conclusion: Routine tasks shouldn’t be complicated
Internal sites are essential hubs of intra-company communication. Easy maintenance of these sites brings even 
more value to the users by making access easy and engagement intuitive.

In our hands-on testing, accomplishing day-to-day tasks 
using Google Sites was simpler and more intuitive. When 
we attempted the same tasks with SharePoint Online, 
we experienced longer wait times—tasks took up to 61 
times longer. 

Allowing us to complete tasks in fewer steps is another way that 
Google Sites streamlined the process; the step-by-step process 
with Microsoft SharePoint Online was more complicated. 
Google Sites also provided users with a consistent experience 
across devices, a consistency that was lacking in our SharePoint 
Online experience. These inconsistencies and extended wait 
times can cause employees to become reluctant to use the 
tool. This can result in less communication, out-of-date content, 
or low employee engagement.

Want to try out the tests yourself? Follow the methodologies at 
the end of the report.

This is the fifth report in our five-part series that examines 
the performance of collaboration and productivity tools from 
G Suite and Microsoft Office 365. Read the entire series for 
a complete picture of how the cloud you choose can affect 
your business.

Additional reports in the “Not all clouds are created equal” series:

A comparison of Google Docs™ and Microsoft Word Online

A comparison of Google Drive, Microsoft OneDrive for Business, and SharePoint Online

A comparison of Google Hangouts™ and Skype™  for Business

A comparison of Gmail™ and Outlook®

1 For our testing, we used the rebuilt Google Sites via the Google Sites Early Adopter Program: https://cloud.googleblog.
com/2016/06/powering-a-more-connected-and-collaborative-enterprise.html

http://facts.pt/jHRnW2
http://facts.pt/pXCZuf
http://facts.pt/gh24hC
http://facts.pt/MnjwGU
https://cloud.googleblog.com/2016/06/powering-a-more-connected-and-collaborative-enterprise.html
https://cloud.googleblog.com/2016/06/powering-a-more-connected-and-collaborative-enterprise.html
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On July 19, 2016, we finalized the hardware and software configurations we tested. Updates for current and 
recently released hardware and software appear often, so unavoidably these configurations may not represent 
the latest versions available when this report appears. For older systems, we chose configurations representative 
of typical purchases of those systems. We concluded hands-on testing on July 26, 2016.

On September 29, 2016, Google rebranded Google Apps for Work as “G Suite.” We completed our testing 
prior to that rebranding.

Appendix A – What we tested
The table below shows the system information for the mobile devices we tested.

System Apple iPhone® 6s Plus Google Nexus™ 6P

Processor

Vendor Apple Qualcomm®

Model number A9 + M9 coprocessor Snapdragon™ 810

Core frequency (GHz) 1.85 1.95 + 1.55

Number of cores 2 8 (4 + 4)

Memory

Amount (GB) 2 (built-in onboard) 3 (built-in onboard)

Type LPDDR4 LPDDR4

Graphics

Vendor Imagination® Technologies Qualcomm

Model number PowerVR® GT7600 Adreno™ 430

Storage

Amount (GB) 64 64

Type NAND Flash NAND Flash

Connectivity 

Wireless internet 802.11ac (802.11a/b/g/n compatible) 802.11ac (802.11a/b/g/n compatible)

Cellular LTE Advanced LTE Advanced

Bluetooth 4.2 4.2

Battery 

Type Lithium-polymer Lithium-polymer

Size Integrated Integrated

Rated capacity (Wh) 10.45 13.11

Display 

Size 5.5” 5.7”

Type LED-backlit widescreen Multi-Touch AMOLED widescreen Multi-Touch

Resolution 1,080 x 1,920 1,440 x 2,560
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The table below shows the system information for the laptops we tested.

System Apple iPhone® 6s Plus Google Nexus™ 6P

Camera

Front-facing (MP) 5 (720p FaceTime® HD) 8

Rear-facing (MP) 12 (iSight®) 12.3

Operating system

Vendor Apple Google

Name iOS Android™

Build number or version 9.3.2 6.0.1

Dimensions

Height 6.23” 6.27”

Width 3.07” 3.06”

Depth 0.29” 0.28”

Weight (oz.) 6.77 6.27

System Apple 13” MacBook Air (Early 2015) Lenovo® ThinkPad® X1 Carbon

Processor

Vendor Intel® Intel

Model number Core™ i5-5250U Core i7-6600U

Core frequency (GHz) 1.6 (up to 2.7 Turbo Boost) 2.6 (up to 3.4 Turbo Boost)

Number of cores 2 2

Cache 3MB L3 4MB L3

Memory

Amount (GB) 8 (built-in onboard) 8 (built-in onboard)

Type LPDDR3 LPDDR3

Speed 1,600 MHz 1,866 MHz

Integrated graphics

Vendor Intel Intel

Model number HD Graphics 6000 HD Graphics 520

Storage

Amount (GB) 256 256

Type PCIe-based flash PCIe NVMe™ SSD



Not all clouds are created equal: a comparison of Google Sites and Microsoft SharePoint Online November 2016 | 11

System Apple 13” MacBook Air (Early 2015) Lenovo® ThinkPad® X1 Carbon

Connectivity/expansion 

Wireless internet 802.11ac (802.11a/b/g/n compatible) 802.11ac (802.11a/b/g/n compatible)

Bluetooth 4.0 4.1

USB 2 x 3.0 3 x 3.0

Thunderbolt 2 x 2 N/A

Video N/A 1 x HDMI®, 1x Mini DisplayPort

Battery 

Type Lithium-polymer Lithium-polymer

Size Integrated 4-cell

Rated capacity (Wh) 54 52

Display 

Size 13.3” 14”

Type LED-backlit glossy widescreen display LED IPS

Resolution 1,440 x 900 1,920 x 1,080

Touchscreen No No

Operating system

Vendor Apple Microsoft

Name OS X El Capitan Windows 10 Pro

Build number or version 10.11.4 1511, OS Build 10586.318

Camera

Front-facing 720p FaceTime HD 720p

Dimensions

Height 0.11” to 0.6” 0.6”

Width 12.8” 13.1”

Depth 8.94” 9.00”

Weight (lb.) 2.96 2.58



Not all clouds are created equal: a comparison of Google Sites and Microsoft SharePoint Online November 2016 | 12

Appendix B – How we tested
About our testing

Network infrastructure
We used two of each device under test. We connected the two devices in each pair to separate wireless networks. We connected the devices 
to the 5GHz band of identical, 802.11 ac-based TP-Link AC1750 wireless routers. We configured each router identically but set them to use 
different channels, to minimize traffic from nearby networks.

Devices
• Lenovo ThinkPad X1 Carbon (Windows 10)

• Apple 13” MacBook Air (OS X El Capitan)

Running the laptop tests

Measuring the time to create a new site
1. In Google Chrome™, navigate to the dashboard page for the site management service being tested.
2. Create the site:

• In Google Sites, simultaneously click the Create New Site button and start the stopwatch.

• In SharePoint Online, click the Create Site button and provide a name, then simultaneously click Create and start the stopwatch.

3. Stop the stopwatch:

• In Google Sites, stop the stopwatch when the new site appears and has fully loaded.

• In SharePoint Online, stop the stopwatch when the new site’s dashboard appears and has fully loaded.

4. Record the result. 

Measuring the time to share site via email
1. Prepare another notebook (the same model as the one being used for testing) by navigating to the browser-based email client for the 

platform under test, Gmail™ or Outlook® Online.
2. On the notebook under test, prepare to share the site:

• In Google Sites, click the Add Editors button, provide the email address being used on the other notebook, then simultaneously click 
Done and start the stopwatch.

• In SharePoint Online, click the Share button, provide the email address being used on the other notebook, then simultaneously click 
Share and start the stopwatch.

3. When the invite email appears in the inbox on the other notebook, stop the stopwatch.
4. Record the result.

Measuring the time to create a new blank page
1. In Google Sites, navigate to the Pages tab, or in SharePoint, navigate to the Site Contents page, and click Site Pages.
2. Create a new blank page:

• In Google Sites, click the Add Page button, provide a name for the page, then simultaneously click Done and start the stopwatch.

• In SharePoint Online, click the New button, provide a name for the page, then simultaneously click Create and start the stopwatch.

3. Stop the stopwatch:

• In Google Sites, when the new page has fully loaded and is editable, stop the stopwatch.

• In SharePoint Online, when the new page appears in the editor and is editable, stop the stopwatch.

4. Record the result.

Measuring the time to open an existing page for editing
1. Open an existing page:

• In Google Sites, navigate to the site under test, then simultaneously click the button for an existing page (that is not currently open in 
the editor) and start the stopwatch.

• In SharePoint Online, navigate to an existing page, then simultaneously click the Edit button and start the stopwatch.

2. When the page appears in the editor and is fully loaded, stop the stopwatch.
3. Record the result.
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Measuring the time to preview a site theme
1. In Google Sites, click the Themes tab, or in SharePoint, click the What’s your style? button.
2. Simultaneously click a theme (other than the one you’re currently using) and start the stopwatch.
3. Stop the stopwatch:

• In Google Sites, when the new theme loads on the page in the editor, stop the stopwatch.

• In SharePoint Online, when a preview of the new theme loads, stop the stopwatch.

4. Record the result.

Measuring the number of steps to add bulleted list and one item
Google Sites
1. In the Insert menu, click Text box.
2. Click the bulleted list icon.
3. Type item text.

SharePoint
1. Click add an app.
2. Click Custom List.
3. Type name.
4. Click Create.
5. Click New Item.
6. Enter a title.
7. Click Save.

Number of steps to add calendar
Google Sites
1. In the Insert menu, under Google Embeds, click Calendar.
2. Click a calendar in the list to select it.
3. Click Insert.

SharePoint
1. Click Add lists, libraries, and other apps.
2. Click Calendar.
3. Provide name.
4. Click Create.

Number of steps to add image to page from cloud
Google Sites
1. In the Insert menu, click Images.
2. Click the Google Drive tab.
3. Click an image to select it.
4. Click Select.

SharePoint
1. Click Edit.
2. Click Insert tab.
3. Click Picture.
4. Click From SharePoint.
5. Click existing image.
6. Click Insert.
7. Click Save.
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Measuring the number of steps to add image to page from computer (upload)
Google Sites
1. In the Insert menu, click Images.
2. Drag an image file to the upload box from a local folder.
3. Click Upload.

SharePoint
1. Click Edit.
2. Click Insert tab.
3. Click Picture.
4. Click From Computer.
5. Click Choose File. 
6. Select existing image.
7. Click Open.
8. Click OK.
9. Click Save.

Number of steps to resize inserted image
Google Sites
1. Click the image in the editor.
2. Click and drag one of the circles on the corners to resize it.

SharePoint
1. Click Edit.
2. Click the image you want to resize.
3. Click the Image tab.
4. Click in either the Horizontal Size or Vertical Size fields.
5. Type the desired width or height in pixels.
6. Press Enter.
7. Click Save.

Number of steps to move inserted image
Google Sites
1. In the editor, click and drag the previously embedded image to the desired location.

SharePoint
1. Click Edit.
2. Click the previously embedded image.
3. Click Image tab.
4. Click Position drop-down menu.
5. Click a position.
6. Click Save.

Number of steps to add text to page
Google Sites
1. In the Insert menu, click Text box.
2. Enter the text.

SharePoint
1. Click Edit.
2. Enter text.
3. Click Save.
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Measuring the number of steps to embed YouTube video in page
Google Sites
1. In the Insert menu, under Google Embeds, click YouTube.
2. Enter a search query.
3. Press Enter.
4. Click the desired video.
5. Click Select.

SharePoint
1. Click Edit.
2. Click Insert tab.
3. Click Embed Code.
4. Navigate to http://www.youtube.com in another tab.
5. Enter search term or phrase.
6. Press Enter.
7. Click the desired video.
8. Click Share.
9. Click Embed.
10. Select Embed Code.
11. Copy embed code.
12. Return to the tab in which SharePoint is open.
13. Paste embed code in the Embed dialog in SharePoint.
14. Click Insert.
15. Click Save.

Number of steps to change site/page theme
Google Sites
1. Click the Themes tab.
2. Click a theme to apply it.

SharePoint
1. Click What’s your style? Change the look of your site.
2. Click the desired theme.
3. Click Try it out.
4. To apply the theme, click Yes, keep it.

Number of steps to create new page
Google Sites
1. Click the Pages tab.
2. Click the Add page icon.
3. Type in the desired page name.
4. Click Done.

SharePoint
1. Click Site Contents.
2. Click Site Pages.
3. Click New.
4. Type in the desired page name.
5. Click Create.

http://www.youtube.com
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Principled Technologies is a registered trademark of Principled Technologies, Inc.
All other product names are the trademarks of their respective owners.

DISCLAIMER OF WARRANTIES; LIMITATION OF LIABILITY:
Principled Technologies, Inc. has made reasonable efforts to ensure the accuracy and validity of its testing, however, Principled Technologies, Inc. 
specifically disclaims any warranty, expressed or implied, relating to the test results and analysis, their accuracy, completeness or quality, including any 
implied warranty of fitness for any particular purpose. All persons or entities relying on the results of any testing do so at their own risk, and agree that 
Principled Technologies, Inc., its employees and its subcontractors shall have no liability whatsoever from any claim of loss or damage on account of any 
alleged error or defect in any testing procedure or result. 

In no event shall Principled Technologies, Inc. be liable for indirect, special, incidental, or consequential damages in connection with its testing, even if 
advised of the possibility of such damages. In no event shall Principled Technologies, Inc.’s liability, including for direct damages, exceed the amounts paid in 
connection with Principled Technologies, Inc.’s testing. Customer’s sole and exclusive remedies are as set forth herein.

This project was commissioned by Google.

Principled
Technologies®

Facts matter.®Principled
Technologies®

Facts matter.®


